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Schematic Editor

Invoke Schematic Editor from Project Explorer in the following ways.

Right click Page [Main Page] and Select Edit Page from the list.
Or

Select Edit Page from the task list or from the task toolbar.
1. Turn ON Grid by enabling the grid from the dropdown, in Standard Toolbar.

2. The value for grid may be selected from the drop down list as .1000".

3. Set Snap value to .0500" for better placement of the components.

Loading the Components

Select Tools & Components toolbar and right click on the workspace to popup a set of

Component editing tools. By default, relocate tool is enabled.

Loading Components using Component Browser

The component browser is launched from View = Schematic = Browser.

The required components can be obtained either by using the Browse option in
the window or by Search for the element in the quick menu
Using the Place button in the bin we can place the components in the workspace.

Note: Hotkeys can also be assigned to element names by which quick launch of

components is possible.

4. Voltage source, Ground and signal generators can be obtained from the

Component Browser. These are external sources (which will not be housed on the
PCB) and hence connections to them can be shown with the help of connectors.
Select connectors from the component browser, then select List Connector and
select the required header from the list appearing.

Load the connector and using Repeat Component function tool, create the
required number of instances. Similarly load SPLO (Hotkey G).

To relocate the component, right click and select tool Relocate. Position the part

where required and click the mouse to place component
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Packaging the Components

If the PCB of the circuit has to be designed, then the components need to be packaged.
Packaging is nothing but information that the system requires identifying the Package
associated to Part placed on the Schematic. Only packaged components are automatically

front annotated to layout.

Auto Packaging
Select Tools = Component = Pack/Unpack Component @ Auto packaging from the

option tool. An Automatic Packaging window appears Click Execute button.

Automatic Packaging |
—Mame prefides found:

Frefis in Part: | Pack: Change to; Start H =

T [ T

C = C 1

5 = 5 1

U = U 1 =

TN 3

E secute | Cancel |

Routing the wire connections

1. Connections between components are established using wires and buses.

2. Select Tools = Connections to enable a set of tools required for routing.

& Tip: Adjust zoom precision to view the terminals being wired. Turn ON grid and
shap to help in positioning the wires.
3. Before creating the connections, enable Preferences/Instant net name and
Preferences/Instant wire label.
Right click on the work space and select Connections.
Enable Pin to Pin option tool whenever an entry or pin is clicked for making a
connection. This ensures that the connection is made to the pin.
6. An input box appears prompting the user to enter the name of the net, enter the

name most suited for the net.

Viewing the output

1. Select Tools = Instruments Set wave form Contents (function tool) = Voltage
Waveform (option tool).

2. Click on the nets where the voltage waveforms to be displayed.
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Entering Page Notes and Design Notes

1. Page notes appear only on the current page (e.g. Page No.) of the project
whereas Design notes appear on all the pages (e.g. Project name) of the
selected circuit.

Select Tools = Page Notes toolbar to enable a set of tools for creating page

2.
notes. Right click and enable
Edit & Add Text Bleck ]
Fant narme: IR-"En:h:ur Fant j
Faont zize: I 0.0s00" j
Font pitch: o.0120"
Teut: B | £ | 11| iil {}l

RC Coupled Amplifier ]

[

Aocept | Cancel |

3. Create PN Graphic Item tool = Create Text to open a window Edit & Add Text

block. Enter the required notes and accept it.
The text gets tagged to the cursor. Now place the text at desired position. To edit this text,

Press Ctrl key and click on the text to select it. Perform the various operations using
bullets.

Schematic Circuit designed is given below.
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RC Coupled Amplifier
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Saving the Project

In order to prevent loss of work, save the project periodically using the following steps.

1.
2.

On the File menu of Project Explorer, Click Save Project or Press Ctrl + S.
The first time Save Project is selected, a dialog pops up prompting to enter the
name for the project.

Type in the name of project as RC Coupled Amplifier.EPB.

Printing the Schematic Diagram

To print the Schematic diagram,

1.
2.
3.

Select File = Print page from the main menu of Schematic Editor.

A window pops up with the preview of circuit diagram.

Click on ‘Fit graphic to one page with margin’ icon. Click on Print Page icon to
print the page.
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Mixed Mode Simulation

Steps for Mixed Mode Simulation

Preprocess the circuit

The simulator analyzes the schematic first and checks for the simulation function. It
generates the data along with the statistics of the circuit. Data includes the number of
digital and analog nets, list of symbols, which may be simulated along with their simulation
functions, number of digital inputs and outputs, number of A/D input/ outputs. This is

presented as a dialog box. Observe that the analog primitives are assigned negative

simulation function.

Click the OK button to close this dialog box. The simulator is now ready for making further

analysis on the circuit.

Simulation

__!j“ﬁ Mixed-Mode Simulation Preprocess Result

Analog Mets ; a3 Digital Mets ]
SPLD | | |

Ciig. Inputs : 0 |2 Capacitor
. : -4 “oltage Source

Dig. Qutputs L -7 Volage Generator

[nput &0 ; ] 1 Pesistar

Cutput 0 Ads 1] -5 MPM Transistar

Components : 12

Primitives : )

|F"repru:u:ess completed

Note: Any change in the circuit element values or topology gets implemented only if the

preprocess is invoked. Preprocess menu is invoked from Simulation menu. Preprocessing

the circuit resets the values set.
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Assign Component Parameter Values

1. Select Component Properties (function tool) =» Change Simulation
Parameters (option tool).Click on the component

2. Component Parameter Setup window opens.
Change the parameter values.

4. Click Accept.

Analysis

For setting up simulation time and Start analysis types,
1. Select Simulation =»Analysis.
2. Set the parameters by selecting General settings from the tree view on the left

side of the window.

F{‘,]EEIZUP Simulation Parameters |
Analyziz Type FParameter Setup
Simulation Lirnits
iy - Ambient Temperature | 25
General Settings -
. . b 2. teration Emar 10m
P %5 Transient Analysis [ 100
------- i'U DC Sweep Analysis Flaating Mo, Precizion | 4
....... b AT Sweep Analysis Min. Dizplayable Lnitz
. Yaoltage it
------- % Monte Carlo Analysis d
i Current 173
....... Frir] il ; - -
niw) SEnaitivity Analysis Dizplay Iteration Emaors |
Display TP Yalues v

Accept Cancel

3. Set the values as

Simulation Limits:

Ambient Temperature 25
Max. Iteration Error 100m
Iteration Limit 100
Floating No. Precision 4
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Min. Displayable Unit:
Voltage mV
Current MA

Click Accept button to accept the changes and to automatically switch to Analysis

option

Bias Point Calculation

Bias Point Calculation is used to determine the DC behaviour of the circuit.

1.

Inorder to view the DC values, fix the test points at the base, collector and emitter

of the transistor as shown below. To place the test points, select Tools =

1

Instruments = | 2> Test points 2

Wt

Voltage TP

kU

Select Simulation = Analysis.
A window Setup Simulation Parameters opens with the option Analysis being
highlighted on the left side of the window by default.

Check Bias Point Calculation check box.

Click Start button, and observe that the node voltages are displayed at the locations

where test points were placed. Similarly current values can also be viewed by placing the

test points at the required nets.

Transient analysis

Transient analysis is used to view the input and output with respect to time. Inorder to view

the performance of the circuit in time frame run transient analysis.

1. Select Simulation = Analysis.

2. Select Transient analysis from tree view.

10
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3. Enter following values:

Analog simulation step time: 2p

Simulation time limit:

1m

%Setup Simulation Parameters E |

Analyziz Tepe

FParameter Setup

....... ERE ANALYSIS

------- % General Settings
[ Tranzient Analyziz
------- F DC Sweep Analpziz
------- "n\J.- AL Sweep Analyziz

------- i Monte Carlo Analysiz

W50

il Sensitivity Analysis

prs

Analog Sim. Step Time 2
Sim. Time Lirnit Tm
Iritialize LC Solve
Drizplay ' aveform v
Transfer Function Analysis C
Accept Cancel

4. Check Display waveform check box.

5. Click on Accept to switch into the Analysis option

6. Click Start to begin the analysis.

200
100

Y1 [lnput]
=

Fa
o o
S 3
< =

V2LOAD)
2w R

=

0z 100pz 2000z A00pz A00pz A00ps

Time

11
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Parameter Analysis

Parameter analysis helps to study the effect of variation of component parameters on the

circuit. This analysis calculates the change in the output of a given circuit when a selected

parameter of a particular circuit element is varied over a range of values.

1. Select Simulation = Analysis.

2. Select Parameter Analysis from the tree view.

FESEIZI.ID Simulation Parameters E |

Select Sweep Variable as Component Parameter type.

Move the cursor over the resistor and click on it. Selected component name and

parameter name appears in the dialog box.

Set the values for the following parameter as
Start Value
End Value

Steps

Analyzsiz Type

Parameter Setup

1K Ohm
3K Ohm
750 Ohm

EE ANALYSIS
% General Settings
Tranzient Analysiz

ST - ameter Ana

- N Fourier Analysiz
- DC Sweep Analyzis
M AC Sweep Analysis
- ponte Carlo Analpsiz

k1)

Sl Sensitivity Analysiz

Sweep Vanahble

Carmp. Parameter

Camp. Mame

R1A1

Parameter Desc

Resiztance [Ohm)

Parameter Mame

R

Analysiz Tupe Sweep
Sweep Mode Linear
Start Walue 1 kOkm
End *alue 3 EOkm
Steps 750 Ohm
Dizplay ‘wWavetarm v
Accept Cancel

Click Accept to switch into Analysis option.

Check Parameter analysis check box.

Now click Start button for analysis to take place. The result may be viewed in the

Waveform viewer.

12
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l“IMMS_Parameter Analysis 1171... =] [E3

=400 s 0= 1 : Aldps A00 [Tk B0l Iz

Fourier Analysis
Fourier analysis helps to calculate the total harmonic distortion of analog waveforms
generated during transient analysis.
1. Select Simulation = Analysis.
2. Select Fourier analysis from the tree view.
3. Set the parameters in the box as
Fundamental Frequency 10K
No of harmonics (nfreq) 10

Deg. of Polynomial (polydegree) 2

13
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%Setup Simulation Parameters E |

Analyziz Type FParameter Setup
....... % ANALYSIS Fundarmental Frequency 100k
_______ ¥ General Settings Mo, of Harmu:unu:.s [rfreq] 10
[eq. of Polynomial [polydegree] | 2

=~ Tranzient Analysis

. #FE Parameter Analyziz

(- Fourier Analyziz
FH DC Sweep Analyziz
Sl AL Sweep Analpsis

s Monte Carlo Analysiz

Sl Sensitivity Analysis

Accept Cancel

After setting the parameter click Accept button to accept the parameters.

Check Fourier Analysis and click Start button. Fourier analysis results are

displayed in a text format.

File Edit Search ‘Window Help _|E|£|

Mixmode Simulation output =========

Project Mame :1_11_0BRC Coupled Amplifier
Analysis Type  © Fourier Analysis

Date - 211172008

Tirne - 10:33:54:690

Fourier Analysis Temperature : 25 Deg. C

Fourier Components of Transient Response Met . LOAD

. i - P ey - PR PR — 3 . . a — x
1| | 3

| 1 open documentis). [CaPs [NUM | NS,

14



EDWinXP Getting Started

Visionics

DC Sweep Analysis

DC Sweep analysis helps to observe the circuit operating parameters by varying the value

of a component. One or more sources (current and voltage) may be stepped over a range.

Results of the analysis at each source value may then be viewed in the waveform

generator.

1. Select Simulation =» Analysis.

2. Select DC Sweep Analysis from the tree view.

3. Move the cursor over DC supply and click on it. Selected component name and

parameter name appears in the dialog box.

4. Set the sweep limits as

Start value
End value

Steps

!‘ﬁﬁetup Simulation Parameters

Analyziz Tupe

ov
15V
1V

Parameter Setup

------- EEE ANALYSIS

------- T General Settings

A Tranzient Analysis

....... DC Sweep Analysis
------- f\j AL Sweep Analysiz
------- -p%*'; Monte Carlo Analysis

5

------- Senzitivity Analyziz

Component]1]

Sweep Vanable

Cormp. Pararmeter

Comp. Mame 111
Parameter Desc | Voltage V]
Parameter Mame |E
Start Walue 0
End Walue 18Y
Steps 1w
Component[2] O
Sweep Mode Linear
Dizplay ‘wavetorm WV
Accept Cancel

© N o v

Click Start

Check DC Sweep Analysis check box.

Select Accept to switch into Analysis Option.

Check Display Waveform check box to display the waveform.

15
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W1 [Input]

W2LOAD)

o A 4 B a 10 12 14y 16

Waltage

AC Sweep Analysis

AC sweep analysis is used to calculate the small signal frequency response of the circuit

assuming its current biasing.

. -
1. Select Instruments 2> £ |Set Reference Points (function tool) = | A |AC IN+

and click on the input net.

2. Select Instruments =2 a&||Set Reference Points (function tool) = | W | AC IN-
option tool and click on the input net.
3. Note: This tool specifies the input given to the input side to be a voltage source or

a current source for running the AC Sweep Analysis.

4. Select Instruments = Set Reference Points a‘EEI| = AC OUT+ |I:-| and click

on the load net.

5. Select Instruments > Set Reference Points a€§|| = AC OUT- | ]:. |and click on
the load net.

6. Note: This tool specifies the output variable taken from the output side to be either
the open voltage or the short current.
Select Simulation = Analysis.

8. Select AC Sweep Analysis from the tree view.

16
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F-'ESEIZI.ID Simulation Parameters

Analyziz Type Parameter Setup
....... % ANALYSIS Sweep Y ariables
------- Yo General Settings el s eiey L
. _ End Fregquency 1G
[H- 5 Transient Analysis Paints/Decade | 100
------- T DC Sweep Analpsis Phase Range | [-180,+180]
; M Saurce Yalkage
ouT 5 Open Yol
------- %‘J Monte Carlo Analysis e bl
- Dutput
------- Sl Senzitivie Analysiz Fieal Part m
|maginary Part O
b4 agnitude v
Phaze vl
Group Delay O
Dizplay ‘W aveform ™2
Accept | Cancel

9. Set the values for the following parameters as

Start frequency 100 Hz

End frequency 1GHz

Points / decade 100

Phase range [-180, +180]
IN source voltage

OUT source Open voltage

10. Click Accept button to switch into Analysis option.

11. Check AC Sweep Analysis check box.
12. Click Start for AC Simulation Pass to take place.

kM agnitude

Phaze

1kHz 10kHz 100kHz 1MHz 10MHz 100kHz 1GHz
Frequency

1Hz  10Hz 100Hz
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Monte Carlo Analysis

The Monte Carlo analysis is used for simulations with a given error on different
components. This test is very useful for visualizing how the circuit will run with imperfect
components as are used in reality.

1. Select Simulation = Analysis.

2. Select AC Sweep Analysis from the tree view.

3. Select Instruments = Set Reference Points £ | = Monte Carlo voltage| i
and click on any of the nets.
4. Select Monte Carlo Analysis from the tree view.
5. Select the component at which the analysis has to be done, by clicking on it.
6. Enter the parameters and click Accept to accept the parameters.
7. Click Start.
e S > |
Analyziz Tupe FParameter Setup
....... % AMALYSIS Component[1]

Comp. Mame A3
FParameter Desc | Resiztance [Ohm)

------- Yo Gereral Settings

-85 Transient Analysis Paramater Name | B

------- T DE Sweep Analyzis Tolerance 10

Mo. of Samples |10

Component[2] r

Function

------- Sl Sensitivity Analysis - Uifarm

Cukprit b awirniamm

Time 10m

Accept Cancel

The result is displayed in a text file.

18
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File Edit 3Search wWindow Help _|5’|5|

Mixmode Simulation
hMonteCarlo Analysis for Maximum and minimum deviation done. .

Cutput for the simulation follows. ..

Mominal output

Companent [1]: B34
FParameter: 5 k
“oltage 540715

Jq [ _>ILI

| 1 open documents] |cops [NUM | N5,

Sensitivity Analysis
Sensitivity Analysis is used to calculate the component that is most sensitive to an output

reference point.

1. Select Simulation = Analysis.
Select Sensitivity Analysis from the tree view.

3. Inorder to determine the sensitivity of a component with reference to a net select

Instruments 2 £ | Set Reference Points | | = Sensitivity voltage

Click on any of the nets and place the reference points.

Select Sensitivity Analysis from the tree view.

Specify a value of tolerance for which the analysis is to be carried out. This is the

common tolerance value for all parameters of all components.

19
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!"gﬁetup Simulation Parameters
Analyziz Tupe Parameter Setup
% ANALYSIS #Change in Parameter Value | 5 |

- % General Settings

H- Tranzient &nalysis

+

-~ - DC Sweep Analysis

P AC Sweep Analysis
Bkl Mante Carlo Analyziz

g

S cnitivity Analysis

Accept Cancel

7. Click Accept button to switched into Analysis option.
8. Check Sensitivity Analysis check box.
9. Click Start button, result is displayed in a text file.

File Edit Search Window Help =

Project Mame 1 11 0BRC Coupled Amplifier
Analysis Type © Sensitivity Analysis

Date D 2172008

Time S 11:54:35:5940

FPercentage increase of parameter value ; 5%

DC Sensitivity of output “oltage at net "COLL"

-
4| | 3

| 1 open documents), |ceps [NUM | INs

20
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EDSpice Simulator

Steps for EDSpice Simulation

Preprocess

Preprocessing confirms whether the circuit is ready for simulation. Preprocessing must be
performed at all times, when elements have been added or deleted from the circuit or
connectivity between them is changed.

Inorder to preprocess the circuit select Simulation = Preprocess

Click Close.

Analysis

Select Simulation =» Analysis

[Circuit Preprocessing: -
=% Higrarchy Stack: =

Current circut; MAIMHIER

M arninal Circuit;

MAINHIER: T1/1 [ EDSpice id: 31 ] - Bipolar Junction Tran_sillj
1| | 3

Cloze

Analysis Setup : |
Simulator ¥ anables(Dptions] -~ Select Analyzes
Initial Hode Woltage Guesses : _
Tranzient Initial Conditions I™ Transient Analysis Setup
Hinalysis} [ Small-Signal AC Analysiz Setup
[l Tranzient Analyziz I
F- Small-Signal AC Analysis [~ DC Transfer Function Analysis Setup
M- D!: Trénsfer FunFtiDn Analysis [ Distortion Analysis Sl
[l Digtartion Analyziz —
- Operating Point Analyziz ™ Operating Point &nalysis Setup
- Moize Analysis I Noi ]
o . Moize Analyzis Sehy
- DCAAL Sensitivity Analysis =R
- Tranzter Function Analysiz [~ DCAAC Sensitivity Analysis Setup
- Pole-Zero Analysis [ Tranzfer Function Analysiz Setup
[~ PaleZer &nalysis Setup

Fun Cancel |
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Transient Analysis

1. Transient analysis is used to view input and output with respect to time.
2. Select Simulation < Analysis.
3. Select Transient Analysis from the tree view.
4. Enter the values as
Step 1
Final time .4m
Start time 0
nalysisetwp:
Sirmulatar ¥ anables(Optionsg) — Set Parameters :
Initial Hode Voltage Guesses tran 1p 4m
Transient |nitial Conditions
Anabﬂs Step 1o
= Tranzient Analysiz Final Time Am
W aveeform Wiewer Start Time 1]
Print[Standard Output) Maw. Step 0
Plot[Standard Output] Temperature
i FourienSetup] As Setup [
[l Small-Signal AC Analpziz Fourier r
- DC Transfer Function Analysis Results
[ Distartion Analyziz
- Operating Point Analysis
- Moize Analyziz
- DCAAL Sensitivity Analysis
- Tranzter Function Analysis
- Pole-Zero Analysis Bl Accept Gl

Click Accept button after entering the values to automatically switch to Analysis
Click Run button to start simulation.

Wlnput]

VILOAD)
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Small Signal AC Analysis
This analysis is used to obtain the small signal AC behaviour of the circuit.
1. Select Simulation = Analysis.
Select Small Signal AC Analysis from the tree view.

3. Enter the values as

Total points 100
Start frequency 10 Hz
End frequency 100GHz

4. Select Waveform for displaying the output.
Click Accept button after entering the values to automatically switch to Analysis.

Click Run button to start simulation

6.
Analysis Setup : E3 |

—Set Parameters :
ac DEC 10010 10Meg

Sirnulator Y aniables[Dptionz)]
|mitial Mode Woltage Guesses
Trangient Initial Conditionz

- Pole-Zero Analysis

Analysis W ariation Decade
[+~ Tranzient Analysis Sweep Parameters
38 Crall-Signal AL Analysis Tatal Paints 100
[#- DC Tranzsfer Function Analyzis Start Frequency 10
[+~ Digtortion Analysis End Frequency 10keg
- Operating Paoint Analysis Temperature
- Moige Analysiz Az Setup
- DCAAC Sensitivity Analysis Fezultz
- Tranzfer Funchion Analyzis

Run

Accept Cancel

—t kel
[P D 0 e
[ s || { | o o | L}

WILOAD Jmagn

200
100

-100

WILOAD Jphaze

-200 L
10 100

1k

10k 100k 1M

frequency

100 1G 106G
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DC Transfer Function Analysis

DC Transfer Function Analysis gives the behaviour of the circuit with respect to the

varied voltage/current.

1. Select Simulation = Analysis.

2. Select DC Transfer Function Analysis from the tree view.

3. Set the values as

Start Voltage 0V
Stop Voltage 12V

Step 1
T |
Simulator ¥ ariables[0ptions) — Set Parameters
Iritial Mode Yoltage Guesses de V11 0121

Trangient Initial Conditionz
Analysis

[+~ Tranzient Analysis

[+~ Small-Signal AC Analysis
B3 D1 C Tranzfer Function Analyzis
[+~ Digtortion Analysis

- Operating Paoint Analysis
- Moige Analysiz

- DCAAC Sensitivity Analysis
- Tranzfer Funchion Analyzis
- Pole-Zero Analysis

Sweep Parameters

First Source

U141 1]

Start Woltage

Stop Yoltage

Step

Second Source

Start Woltage

Stop Yoltage

Step

Temperature

Az Setup

Fezultz

Run

W avefarm

Accept | Cancel

4. Select Waveform for displaying the output.

5. Click Accept button after entering the values to automatically switch to Analysis.

6. Click Run button to start simulation

1151.A1] §

Y[COLL) g

YIEMITT) ié

YW[BASE] ig

0

10 12
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Distortion Analysis

The distortion analysis computes steady state harmonic and intermodulation products for
small input signal magnitude. If signals of a single frequency are specified as the input to
the circuit, the complex values of the second and third harmonics are determined at every
point in the circuit. If two frequencies are specified at the input of the circuit the analysis
finds out the complex values of the circuit variables at the sum and difference of the input

frequencies, and at the difference of the smaller frequency from the second harmonic of
the larger frequency.

1. Set the frequency, Select > Component parameters (function tool) -)| ﬂ'r(ft] |
Change Simulation Parameters option tool.

2. Select Simulation = Analysis.
Select Distortion analysis from the tree view.
Inorder to run distortion analysis, specify the analysis parameters by selecting

Distortion Analysis from the tree view on the left side of the Analysis Setup.
5. Setthe values as

Total points 100
Start frequency 10Hz
End frequency 10Meg

Click Accept button after entering the values to automatically switch to Analysis.

7. Click Run button to start simulation. The output obtained is a text file.

Analysis Setup : |

Sirnulator Y ariables[0ptiong) — Set Parameters :

Initial Mode Yolkage Guesses disto DEC 10010 10Meg 25

Tranzient Initial Conditions

Analyziz W ariation Decade

-- Tranzient Analysis Sweep Parameters

-- Small-Signal AC Analpsiz Total Points 100

-- DC Transfer Function Analysiz Start Frequency 10

=8 Ditortion BAnalyziz End Frequency 10Meg
i W avefaorm Yiewer Spechal Analyziz v
Print[Standard Output] F20VERFT 25
Plot[Standard Output] Temperature

- Operating Point Analysis Az Setup

- Moize Analyziz Rezultz
- DCAALC Senzitivity Analpziz
- Tranzfer Funchion Analyziz
- PoleZero Analpsiz

R Accept Cancel
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=| File Edit Search Window Help

=18 %

ml'itle: 1 11_06RC Coupled Amplifier: - Distortion Analysis
Date: Mon Mov 20 12:45:50 2006
Temperature: Z7.000
Flotname: disto3:DISTORTION - [h: 2f1-12
Flags: complex
Ma. Variables: 3
Ma. Foints: 1
“ariables:
a frequency frequency
1 wl2) voltage
2 (=] voltage
“alues:
a 1.000000000000000:+301,0.000000000000000.-+00
0.000000000000000e +00 0.000000000000000e+000
3.388909351 3664 27 e H100 2. 45927929634 2058:+001

=

2 open document(s). |ceps [NUM | N5
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Operating Point Analysis

Operating Point Analysis is used to determine the DC behaviour of a circuit. This is done
automatically when an AC analysis and Transient Analysis is done.

1. Select Simulation = Analysis.

2. Select Operating point Analysis from the tree view.

3. The default selection is ‘As marked’ means that results will be displayed at all
markers placed on the circuit schematic. After analysis, the values will be
presented by updating the markers.

4. If we want to know the values at all nodes and branches of the circuit, select ‘All
Points’ the results can be viewed in the RAWSPICE.RAW file, For that Select
Options = View EDSpice Files = Raw file, from that Open rawspice.raw file.

Analysis Setup : |
Sirmulator Y ariables(0ptions) — Set Parameters

Initial Mode Yoltage Guesses

Transient Initial Conditions HE_SUItS \W

Analysis Paints

-- Tranzient Analpsis

- Smal-Signal AT Analysis

[ DC Transfer Function Analysis

= Distortion Analysis
W aveform Wiewer
Print[Standard Output]
Plat(Standard Qutput)

- Operating Paint Analysis

- Moize Analyziz

- DAL Sensitivity Analysis

- Tranzfer Funchion Analysiz

- Pole-Zern Analysiz

Run Accept Cancel
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Noise Analysis

Noise Analysis is used to analyse the noise existing at any point in a circuit, due to the

combined effect of all noise sources in the circuit.

1. Select Simulation = Analysis.

2. Select Noise Analysis from the tree view.

Sirulator Y ariables[0 ptions]
Initial Mode Yoltage Guesses
Trangient Initial Conditions
Analyziz

[#- Tranzient Analysis

- Small-Signal AC Analpsiz
[#- OC Trangfer Function Analyziz
[+ Diztortion Analysis

- Operating Point Analyziz
B M oize Analyziz

- DAL Sensitivity Analysis
- Tranzfer Funchon Analyzis
- Pole-Zern Analysiz

mnaysssetp: )
— Set Parameters
noize W[E] Y10 DEC 10010 10Meg
Select Met/Source | Ref. Met
Cutput Y anable WILOAD]
Input Source
W ariation Decade -
Sweep Parameters
Total Paints 100
Start Frequency 10
End Frequency 10keg
Paintz/S ummary 1] LI
Run Accept Cancel |

3. Set the simulation parameters such as start frequency, end frequency, total points

etc.

4. After analysis the Noise Spectral Density Curves will be presented in the
Waveform viewer as shown below.

50f

40f

incize_spectrum 30f
20f

10f

I}

Ef

......

Af
. 4f
onoize_spPEciium o

2f
1t

0 i B HARA

1a

100 1k

10k

frequency

100k

™ 10m

5. The total integrated Noise will be presented in the rawspice.raw file. It can be

viewed from Options =» View EDSpice Files = Raw file, this .raw file is pasted

below.
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File Edit Search ‘Window Help _|5’|5|

Title: 1_11_DBRC Coupled Amplifier: - Moise Analysis 3
Date: Mon Mov 20 13:10:43 2006

Termperature: 27.000

Flotnarne: noisel:Integrated Moise - W2 ar A2

Flags: real
Mo, Yariables: 2
Ma. Paints: 1
Wariables:
0 onoise_total voltage
1 inoise_total voltage
Walues:

0 5.754142702638551 e-005
1.957670426641511e-013

Title: 1_11_0BRC Coupled Amplifier. - Moise Analysis =

AT A A S e

1 open document(s]. |cops [NUM | INs
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DC / AC Sensitivity Analysis

This analysis helps to calculate sensitivity of an output variable (voltage and current) with
respect to all circuit variables, including model parameters.
1. Select Simulation = Analysis.

2. Select DC / AC Sensitivity Analysis from the tree view.

Simulator ¥ anables(Dptions]
Irnitial Mode Voltage Guesses
Tranzient |nitial Conditionz

— Set Parameters :

Analysis Setup : E3 |

zens [[Y11]4C DEC 10010 10Meg

Analysiz ] ] Select Met/Source | Ref. Met -
- Tranzient Analysiz Dutput ¥ ariable
I LIRS Output Variable | 10171 V11
- DC Transfer Function Analysiz T emperature
[+ Digtartion Analyziz A3 Setup ]
- Operating Point Analysiz Mo PRI ﬂ
leealys — ’ AL Sengitivity Analysis
2 by Analyzis =
" " Y ariation Decade
- Tranzfer Function Analyzis = =
- Pole-Zern Analpgiz weep Parameters
Tatal Points 100
Start Frequency 10
En Frequency
Fun | Accept | Cancel |

Click Accept button after entering the values to automatically switch to Analysis.
Click Run button to start simulation
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10 100 1k 10k 100k 14 10k 100k
frequency

5. After analysis the results of the DC Sensitivity Analysis will be presented in the
rawspice.raw file, open this file from Options View EDSpice Files Rawfile.

6. The results of AC Sensitivity Analysis will be presented in the Wave form
viewer.

File Edit Search Window Help ==

ml'itle: 1_11_06RC Coupled Amplifier; - DCAAC Sensitivity Analysis ﬂ
Date: Mon Mow 20 13:25:32 2006

Temperature: 27 000

Plothame: sensi

Flags: complex

Mo. “ariables: 50

Mo, Faints: 602

“Yariables:
0 frequency frequency grid=3
1 cf _w  wvoltage
2 cf voltage
3 cd voltage
4 co w  woltage
5 cd w  woltage
B cd valtage =]
1 open document(s]. |ceps [NUM | INs
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Transfer Function Analysis
The transfer function analysis calculates the small signal ratio of the output node to the
input source, and also the input and output impedence of the circuit.

1. Select Simulation = Analysis.

2. Select Transfer function Analysis from the tree view.

3. Set parameters and click Accept to accept these values.

Analysis Setup : |
Sirnulator Y ariables[0ptiong) — Set Parameters :

Initial Mode Yolkage Guesses tE4E.2] 10

Tranzient Initial Conditions

Analyziz Select Met/Source  [Ref. Het

[ Tranzient Analyzsiz Cutput ¥ anable WILOAD] I npLat

[+ Small-Signal AC Analysis Cutput ¥ anable

[+ DC Transfer Function Analyziz Input S ource 511 [W10]

[+ Distortion Analyziz

- Operating Point Analysis
- Moize Analyziz

- DCAALC Senzitivity Analpziz
B T ranzfer Function Analyziz
- PoleZero Analpsiz

R Accept Cancel

4. Click Run button to execute the analysis.

5. After the analysis, the results will be displayed in the .raw file. Open this file from
Options = View EDSpice Files = Rawfile.

File Edit Search ‘Window Help oy = |
Mitle: 1_11_OBRC Coupled Amplifier: - Transfer Function Analysis
Date: Mon Mov 20 15:01:20 2006
Termperature: 27.000
Plotharme: tfl
Flags: real
Mao. Yariables: 3
Mo. Paints: 1
“Yariables:
0 transfer_functionvoltage
1 output_impedance_at wB 2 voltage
2 v10#nput_impedance  wvoltage
alues:
0 -1.000000000000000e-+H000 .

1.000000000000000 e +104
1.000000000000000e +H220

=

1 open documents). [CAPS NUM | INS
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Pole- Zero Analysis

Pole- Zero Analysis is most commonly used for determining the stability of control circuits.

This computes the poles and / or zeros in the small signal ac transfer function.

1. Select Simulation = Analysis.

2. Select the Pole Zero Analysis from the tree view.

=]

Analysis Setup :
Sirnulator Y ariables[0ptiong) — Set Parameters :
Initial Mode Yolkage Guesses pz 30E0DCUR ZER
Tranzient Initial Conditions
Analyziz Select Modes
[ Tranzient Analyzsiz Mode 1 IM [3]
[+ Small-Signal AC Analysis Mode 2 SPLO O]
[+ DC Transfer Function Analyziz Mode 3 LOAD [E]
[+ Distortion Analyziz Mode 4 SPLO O]
- Operating Point Analysis Select Polez/Zernes
- Moize Analyziz Tranzfer Function CURZER
- DCAALC Senzitivity Analpziz
- Tranzfer Funchion Analyziz
B Fole-Zero Analpziz

R

Accept Cancel

Click Accept button to accept these values.

Click Run button to execute the analysis.

After analysis, the results will be displayed in the .raw file .For opening this file

select Options »View EDSpice Files <»Rawfile.

Diate: Mon Mow 20 15:16:14 2006
Temperature: 27.000

“ariables
0 zero(1) voltage
1 zerold) voltage
2 zero(d) voltage |
3 zero(d) voltage
4 zerofd) voltage
alues:
0 -2 267 406215754985 +110 0.000000000000000 e +300 =|

Mitle: 1_11_0BRC Coupled Amplifier: - Pole-Zero Analysis

1 open document[s)].

|CAPS MUM | INS
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PCB LAYOUT

PCB Layout is invoked from Project Explorer in the following ways.

Right click PCB Layout and select Edit PCB Layout from the list.
Or
Select Edit PCB Layout from the task list or from the task toolbar.

Define board outline

Select Tools = Board Outline

2. Select Define Outline (function tool) = Create Board (option tool). This tool
enables free hand drawing, using which a board of desired shape can be drawn
on the workspace.

3. To select a pre-defined board format, select the option tool Textual Mode. The
Properties Board Outline (Create) dialog pops up.

4. Enter the desired values and click Accept button.

Properties Board Dutline{Create)

- Board Dutline Froperty  |Value
* pozitioh 0.000mm
' pozition 0.000mm
Line width 0.127mm
Gap (1. 3048mm
Shape ﬂ

width e

Height Circular
Palygon

1 LEEEt Cancel

i

Relocating the components

The components placed on the schematic, which contain both symbol and package, are
front annotated to the layout after packaging. These components are positioned at board
datum (0,0) automatically and may be relocated either manually or automatically

Note: Only parts that contain both symbol and package will be automatically back

annotated to the schematic.
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Before we start loading Parts on to the page, turn ON Grid by enabling grid from
the dropdown, in Standard Toolbar. The value for grid may be selected from the
drop down list as .1000".

Similarly, set Snap value to .0500" for better placement of the components.

Select Tools »Components FRelocate Component (function tool) to relocate
the components.

Enable Ratsnest (F7 key) option tool of Relocate Component function tool to
view ratsnest while relocating the components to ensure that components having
a large number of interconnections are positioned close to each other. Pressing
shift key while relocating/ stretching an item allows the item to move/ stretch

smoothly.

Routing the Components

Connections between components may be established by using Traces and Copper Pour

areas.
1.

Select Tools 2»Connections = Route (Function tool) to enable a set of Routing
tools on right clicking the workspace.

Adjust zoom precision to view the pins properly.

Turn on Preference/ Guidelines (Next unconnected node) before routing
because this option guides you to take the easiest path to route.

Select True Size and Pad frames from View/ Layout, enabling you to select
proper trace size. This also prevents you from creating errors such as traces

crossing over pad, traces very close together etc.
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5. First route power and ground signals (Net SPLO and +5V). In Project Explorer,
select Project / Project Design Rules and set the routing width to 0.030” for
Pwr/Gnd lines and 0.013" for Signal lines.

To start routing traces, first select the power points

7. Select layer for routing from Layers in the main menu. 28 layers are available for
routing. By default COMP LAYER is selected. Click on pin to route on SOLD
LAYER.

a5
4 Tips: While routing, enable the tool A Snap Trace by 45 degree to change

routing directions in steps of 45 deg only.
8. Move cursor with 45° angle through a short distance and click at the nearest point.

9. Terminate routing of the trace by pressing END or F4 key on your keyboard. Or

click on the tool E_E End Connections.

Auto Routers

The three Auto routers available are:
1. Autorouter-Arizona
2. Autorouter-Specctra

3. Autorouter-Maxroute

Arizona Autorouter
Arizona auto router is an integrated module of the EDWiInXP. It uses its own temporary
project and simplified graphics. The Arizona auto router allows routing the traces of a PCB

Layout automatically.

Auto routing using Arizona Auto router

1. Select Auto = Auto Router = Arizona.

2. Select File = Load board to route from project.

3. Select Parameters Setup (function tool) & Routing Parameter Settings (option
tool).

4. Check Solder Layer in the Routing Parameters Settings window
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Routing Parameter Settings E |

Lavers | Clearance I Setup costs I "Width &"\-"ia| FanDutI Optirnize u:u:ustl

Laver

Direction

Pow,

[ COMP.LAYER

Haorizontal

[

Sig. | =
v

[ GLUE MasSK

[ 4LT.GLUE MASK

=l

Accept

Cancel |

5. Select Auto routing Routines (function tool) = Start Auto Router.

6. Select Auto routing Routines = Miter.

7. Close Arizona Auto router window, Click Update project and Exit to save the

project.
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Testing the Board

While designing a PCB, it is quite obvious that a number of errors may occur. These errors
may be in the form of overlapping pads, unconnected Nodes, traces crossing another
trace, etc. Such errors must be taken care of before printing the PCB. To find out such
errors, certain checks on the board are done. Connectivity and DRC check are the two

checks.

Connectivity Test

Connectivity test may be used to check whether there is any electrical discontinuity
(unconnected nodes or deleted trace segments) in a single net. By setting certain
parameters, the test can be performed either on individual nets or all the selected nets.

1. Select Tools = Connections = Connection Property =» Test Connectivity

Connectivity Test |

Select Mets I Connectivity Test | Fiesultsl

Ayvailable Mets Selected Mets
BASE [t
COLL LOaAD
EMITT SPLO
M Yoo

Select Mets for Connechivity Test...

Cloze |

2. Click on the board or on a net. The Connectivity Test dialog pops up.

Select the required nets using the move keys and click the connectivity test tab.
4. Select Connectivity test tab, set anyone of the three options:
Stop at first fail: Test stops at the first occurrence of error.
Test all selected Nets: Checks whether all Nodes of the selected Nets are
connected.
Test single Net: Checks connectivity of the Nodes of the selected Net.
5. Click the Test button to display the results.
Perform this test until “Tested Nets — Fully Connected” message is displayed in

this window.
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Design Rule Check (DRC)

This utility is used to create an error free board to enhance the efficiency of your board. It
automatically smoothes, miters, and checks for both aesthetic and manufacturing
problems that might have been created in the process of manual or automatic routing. This
test helps us to check the clearance between pad to pad, pad to trace and trace to trace.
Select Autocheck from Auto Menu. The Clearance Check dialog pops up.

Select the layers and enter the clearance value in the window.

To select all the layers used in the project click the Set To Used button.

Click Execute.

Clearance Check Setup |

Check Clearances | Check other DR Viu:ulati-:unsl

Layer names Check | =~
B COMP.MASE

[ COMP L&YER
I GLUE Mask
[l LT GLUE MASK

o | oo |~ [ o o | e | | o [ — [
[}

=
=
v

=

Setto Used |

— Checks & Clearances

[+ Padto Pad: ID.EDSEmm
[+ Padto Trace: ||:|_2E|32mm
¥ Traceto Trace: ||:|_2|:|32mm
Channel width far Single

Trace Check: I1 27

¥ Use clearances as in design wiles for lapers

Execute I

Cancel |

3D Board Viewer
3D Board Viewer gives idea on how the components are located, whether there is risk of
friction between components due to their height and shape, the side on which components

are placed, etc.

Select Tools = 3D Board Viewer to view the 3D board
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3D View Control box appears, in this we can select options to view the board in any

direction.

41



EDWinXP Getting Started Visionics

Board Analyzers

EDWinXP provides two board analyzers.
Thermal Analyzer
Electromagnetic Analyzer

Thermal Analyzer

The Thermal Analyzer is intended to be used for analyzing and identifying

potential

thermal problems on a Printed Circuit Board. It evaluates the Temperature Distribution on

a finished PCB, at steady state conditions.. The result of the analysis may be displayed

using isotherms or color mapping scheme.

Steps for Thermal Analysis

1. Right click on the PCB Layout in the Project Explorer. Select Board Analyzer in

the list.
2. Select the Thermal Analyzer tab.

3. From Analysis, choose Settings to open the settings window and click the

Display Options tab. Click on Set to default button .

4. From the Analysis menu select Settings click and select the tool

Board

Parameters Click on Set to default button

5. After supplying necessary parameters, right click and select the tool o

to execute the analysis. The result is displayed in the form of isotherms.

Execute
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6. Color mapping of the board may be viewed by switching on the option View-

>Analysis Results->Colored board.

Componenth Print

7. 3D Board may be viewed by switching on the option View->Analysis Results-

>3D Board Viewer. This option allows to view the temperature distribution on the

circuit in the form of a 3D graph. The higher the temperature, the higher will be the

location of the point on the graph.

J ||||" )

8. The analysis result is obtained. From the result it may be easy to identify the most

heated up component so a heat sink of about may be used.

9. To simulate the heat sink effect, Select the tool

il

Component Parameters and

click on the component. A Thermal Parameters window pops up where you may

set the cooling parameter for the component. Check Component Mounted Heat

Sink check box, enter the Thermal Resistance of Heatsink (e.g. 1.2°C/Watt)

value and click OK. Repeat the same step for all other components and execute
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the analysis again. You can notice the change in the isotherms after conducting
the thermal analysis.

10. Labels may be placed to display the temperature at various points on the board.

For this right click and select the tool ® Set/ Delete Label and click on the
board at required locations. Label gets tagged to the cursor. Now drag the mouse
to place the label at proper place.

Note: To delete the isotherm label click again on the label.

Electromagnetic Analyzer

Electromagnetic Analyzer is used to predict the intensity of electromagnetic field
generated by the working circuit on the PCB. An electromagnetic field develops when
voltage passes through the traces on board. Once the routing of traces is complete,
electromagnetic analysis may be performed on the board. The Electromagnetic Analyzer
measures the distribution of the Electric Field Intensity on a finished PCB. The isolines
show the distribution of the field intensity on the board. Under the electromagnetic

analyzer you can perform Signal Integrity Analysis and Field Analysis.

Steps for Electromagnetic Analysis

1. Select Electromagnetic Analyzer tab, Right click and select the tool
Electrical Parameters .

2. The board parameters are set to the default values by clicking the Set to default
button.
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Met Electrical Parameters

—Select Met Currently Set Met Parameters

Met Mame Yolkage [ | Frequency

] 1h

COLL a 1hd

=) | EMITT ] 1

IM a 1h

It 5 1k

LOAD ] 1

SPLO al 1k

Voo ] T

_*|

Wiew Traces Set to Default

78. 12°F 78.40°F

78.22°F
79.089°F

78.22°F

3. If you select the Set to default button, the default parameter gets loaded into the

text boxes. To move Net from Select Net to Currently Set Net parameters use

key and to move backward use Ll key.

4. View the electrical parameters of the trace from point to point using the View
Traces button after selecting the particular Net Name

5. After adding these nets you may execute the analysis directly. For this right click
and select the tool Execute Analysis. The result is displayed in the form of

isolines.
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6. Color mapping on the board and may be viewed by switching on the option

Colored board under View = Analysis Results = Colored Board. The analysis

result is obtained. The Maximum and minimum field intensity locations can be

observed.

CompandgEsPrint

7. Labels may be placed to display the field intensity at various points on the board.

For this select the tool

i)

Set/ Delete Isolines and click on the board at required

locations. Label gets tagged to the cursor. Now drag the mouse to place the label

at proper place.
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B.0844888uV m

@.034639uY/m

Signal Integrity Simulation

The Signal Integrity Analyzer examines the probable distortion of high-speed signals as
they pass through traces on the PCB. The results of the analysis are displayed in the
Waveform Viewer. The purpose is to predict how a signal deviates from its ideal (or

intended) behavior in a real-world setting.
Steps for Signal Integrity Analysis

Under normal working conditions, signals propagate from some pins of the components in
the circuit (technically called Driver Nodes), through the interconnecting traces and into
pins on the same or other components (called Receiver Nodes).

This analysis detects the degree of distortion of the signal from its ideal behavior while it
passes through the trace and graphically presents the comparison result with the help of

the Waveform Viewer.

1. Signal Integrity Analyzer is invoked from within the Electromagnetic Analyzer.

Right click on the task ﬂ PCB LAYOUT in the Project Explorer to unfold a list
of functions. Clicking on Electromagnetic Analyzer in this list opens up this

module.

mn
Tifv

2. Right click on the workspace and select the tool Signal Integrity and click on

any of the trace, which is to be analyzed.
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3. Now select a net. A window pops up where you may set all the parameters for
simulation. To check the integrity of an electromagnetic signal while it passes
through this trace, go through the following steps.

4. All nets are displayed in the frame Available Nets. Select a net from the list and

click il .The segment nodes of the selected net get displayed in the frame. Right

click on any of the node and set it as driver node and another node as receiver
node.

Met: LOAD - Signal Integrity Simulation {Propagating node:R5,/2)

Mode Parameters | Simulation EE

Selected Mets . [ Met: LOAD, Node : Ri5/2

oo
ml: """ Driver node

| Reciever node
"« Simple node

el
T

'é Remove Net

Mo Parameters Asvailable
[~ for the Selected ltem!

Available Mets . 1' il

e

L]
ﬁl"

Show Trace Segments

Board Parameters Cloze

5. The electrical properties of the trace will influence the signal as it passes through it
and this is shown in the respective columns. The Trace Segment parameters of

the driver node may be viewed by clicking on Show Trace Segments .
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Mek: BASE - Signal Integrity Sinnalation: (Propagating node:T1,2)

Mode Parameters | Simulation &
Celected Mets . | Met: BASE, Mode : 7142
=gy BASE Parameter Walue u
- i NS Technalogy TTL
- g R3/2 Function Square Pulze i
...... =T Resistance [B ouf] 150{ Ok
...... g 0142 Inductance [L out] an|H
Capacitance [C out) 7p|F
Yoltage min 0y
Waltage max B
TL-xH 0|z
T High Tpl =
Awailable Mets .. 1' il TH-»L 0=
COLL 5.1M il Tulz
EMITT 5.1M
IM 5,1k
[put 5,1k
LOAD 5,1
SPLO 51M LI Show Trace Segments
Board Pararneters Cloze

10.

11.

Set the following parameters.
Max voltage to 5V
TL>H=0
TH=1us
TH>L=0
TL=1us

Set TTL technology to the receiver nodes. Check the check box corresponding to
Test Points. The Test points allow displaying the output of the selected node in
the waveform viewer. If no test point is selected then output waveform alone is
displayed on the waveform viewer.

To execute simulation, Start time and End time of the simulation as well as the
sampling time interval must be specified. This corresponds to the parameters Start
time, Time limit and Time step. Enter 1n for Time Step and 2us for Time limit.
Click on Calculate button. The Calculate button allows to calculate the maximum
time limit and will update the text box Time limit. Here the time step is set to 1ns
and Time limit to 2us.

Check the box Generate Waveform. Click the Simulate button to process the
simulation.

The waveform obtained after simulation is shown below.
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Field Analyzer

The Field Analyzer is a tool for studying the electromagnetic fields that are created when
power and/or signal traces on the board are energized. The results of the analysis may be
view as a color graph, isolines, 3D-wire mesh graph, etc. It must be particularly mentioned
that, just as with the other two tools, the Field Analyzer does not make any decisions or
suggestions about the proper functioning of the design. The Field Analyzer predicts the
variations in the selected field, due to electromagnetic properties of physical connections

(traces), within a spatial area and time frame specified by the user.
Field Analyzer - Operation
Invoke Field Analyser from Signal Integrity Simulation window.

Check the option ‘Display Fields’ in the Signal Integrity Simulation window.
Click the Simulate button to open the Field Analyzer.
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The Tool Box on the right side of Field Analyzer includes

Graph Modes

Tool Box

| %

e | Graph Modes 5
Graph extent[m];

B o &

Select Field:

|Hefl € afln]
Graph:

|sjEAEE

= Graph Params. 5

|zalines density: I'I 1] :I

Color graph
Precizion razter: IdD:-:fiEl j

Digplay gnd: |3:-:3 j

Graph center

K[m]: [0.00
Yim]: [0.00

e | Contrals |
Time Step: [100p5x1=1 +]

Mo of steps: [2000
2 | nf =

|

Field values

Plot settings I

Autozcals maximal v

The Graph mode includes

Graph Extent:

| »

Size of the square covered in the graph can be adjust using the zoom out and

zoom in button.
Select field

It includes Electric field, Magnetic field, Vector potential, Scalar potential. Output

can be viewed by selecting each field.

Graph.

In this option of Field Analyzer, five types of graph can be viewed. Colored

[
graphlE, Isoline, field direction graph

@ ,3D graph @ .

, Polar coordinates graph
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Graph Params.

Isolines density

More detailed presentation of the result can be obtained by increasing the Isolines
density in the Graph Params.

Color graph:

Precision raster:

The precision to calculate the field values can be adjusted using the Precision
raster.

Display grid:

Applying higher values to the Display grid will provide smoother variations to the

colored graph.

Controls

_hl Run Simulation button used to begin the Analysis. .

The simulation may be interrupted (and continued later) at any desired point by
using the LI Pause button.

In order to continue the interrupted analysis, simply click the Ll Continue Run
button.

Ll Stop button stops the simulation.

Plot settings
You can view the Field Analyzer Diagram by setting the parameters as your need.
If Auto Scaling has been selected, the maximum values displayed as well as the
scales of the graphs are automatically updated. On the other hand, if Auto Scaling
has been turned off, these values are clipped at the values specified. (In other
words, values higher than those specified are ignored.).
Different magnetic field, electric field, vector potential and scalar potential graphs

can be viewed by selecting Select Field and Graph in Graph Modes.
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Electric Field Polar Co-ordinate Graph

Field Analyzer

060

=

Tool Box

[

0

| e e

e e |

o

1]

/
N

| Graph Modes 5§
Graph extentim]:
Select Field:

[

Graph,

o Graph Params, H

0,40

050 =0.40

020

080

0. iy M
(0 O i

-01.0¢

-0.0g

3.0

10.0n

15.0n0

lznlines density: |1 ] ﬂ

Calor qraph
Precision raster: IJIIJ:-:4IJ ﬁ

Display grid: |3:43 =
Graph center

[l IEI:EII.'.I'
[l IIZI:DI]

Contrals H

Time Step:
I 2%-39n

2 | [ =

|+

Plat seffings h

Field walues

Autoscale mawimal [V

Magnetic Isoline Graph

CTES——
0.60 =l Tool Box | X
| Graph Modes i
0.40 Graph extentm]:
a0 @ -
e 1 Select Fisld:
| Hz ” £ A I Fi:|
Graph:
: PooN ek .
& B =] & A
-0.20 e | Graph Pararis, |'
th |solines density: |1 0 :I
Color graph
Lt Precision raster: |4Dx4ﬂ j
Diizplay gnd: |3H3 j
ag0  |040  |ozo o 020 (040 (060 Graph certer
= ] [000°
4 AH ¥ml: |EI:U|]
oo | Controls I
H2.0m Time Step:
00 | 0% - O ms
00 2 | W =
10.0m 'ﬁ‘ = I Flat setti-ngs |‘
o Field values
) =hin 100 1500 Autazeale maximal hd
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Magnetic Field Direction Graph

Field Analyzer -

050 | o w- Tool Box |X
-::Z.: 2 : o | Graph Modes Fii=
e del e Giaph exterifm
i Rl VRS B | 10 &
S e Select Field:

i
-
P
-
)
P

RN |Hz’||E p’_-‘il Fi:|

BR >
R R
“:I’:‘r :::::"’—‘Jn’dilll\
...... . Forwrm i d poan E .
e CaA il Graph
B e e 7 g 3B
Th e IE .t‘_'?”t}a @I‘Ql
- S R I =% +
3w b I B I S FRETL LR PO
: T i P i
0:z0 : A ! | Graph Params. g
e . £ s
S |zalines densﬂg:hﬂ j.
Color graph

Precision raster: |40s40 :I

Display gnd: |3:<3 ﬁ
Graph center

Km: I&EID'
Yim: [0.00

G B I Controls I‘
40.0m Time Step:;
300 | 0%-0ms
00 o) o/ m
soonf A | Plat seftings |
o U \ Field valuez ;
o 5.0 0.0 1510 Autoscale maximal [V z

Magnetic Field 3D Graph

Field Analyzer i

= Tool Box | X
| Graph Modes H
Graph extentml:

0gs & -

|

Select Figld:
i | e | Bl
Graph;
BBk &l
&_ﬁ = Graph Params, H
lzolines density: I‘I 0 ﬂ
B 4 Color qraph

a r Precision raster: I4Dx4ﬂ ::I
- J 2 p Dizplay grid: |3H3 j

= Hm]: IB:DD'
e ;H [l ID.:-DD

& o | Controls |5

6.0 Time Step;

| 0% - O ms

40 _FI LI ll
20 fh - Plot settings g

Eigld walues
Lutoscale maximal [ -

04
i} a.0n 10.0m 1500
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Fabrication Manager

Introduction

Fabrication is the last stage of the electronic design process. The PCB information is
converted into ASCII output files — GERBER (.gbr), NC Drill (.ncd), PCB Assembly
Outputs Generic (.pck), IPC-D-355(.355), Bare Board Testing Generic (.bbt) and IPC-D-

356A(.356) which are input to machines to finally create the hardware.

1. Invoke PCB Layout in the Project Explorer.

2. Select Fabrication Manager from the tasklist or Select from the task toolbar.
The Fabrication Manager window opens with a default board size and gets aligned
with the Project Explorer to fit the screen.

| Fabrication

Setup
Execute Gerber Template

Exparks

3. Invoke Fabrication Data Manager choose Setup from Fabrication.

4. Choose Gerber Artworks in the left pane of Fabrication Data Manager .

== Fabrication Data Manager

Categary Gerber Photoplotter Data
=- G:Ebef Photoplotter D ata B | Dutput File Locations and Mames ﬂ
- Gerber Artworks Location D:AE D/ NXPAIOEY
. Gerber Mechanical Plats File Mame Prefis RC Coupled Amplifier_tMAINHIER
= NF'D”" Data B | Gerber Dutput Format
| _ - Output Contents Output File Format Standard RS-274X
i PCB Azzembly Output -
Bare Board Testing Dutp_u.t Units Inches
Precizion Format 2.3
Omitted Zeroes Leading
Scale Factar 1.0000
B | Photoplatter Optiohs
Circular Interpolation supported [
Filled Palpgon: Supported v
Square Flazh Fill for Rectangles r
Embed Offzet and Stepping Commands [l
tined Polarity Plot [Copper Pour Areas) [
B | Aperture Table
Aperture T able ype Embedded
M acrogz/S pecial Apertures supported [l
Bl | Dffset and Stepping Definitions
hits Inches
Mumber of Haorizontal Steps 1 ;I

Cancel |
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Gerber Output

GERBER is the standard format used as input to photoplotters that generate the design
data on films. These films are used as masters for manufacturing the PCB, the physical
realization of the schematic data. GERBER format is a vector format for defining various
elements of the layout. This format represents all traces as draw and the pads that are

part of the component footprint as flashes. The Photoplotter uses this command language

Select the layers for which we want the Gerber Artwork files.
Click Execute.

‘Gerber output window’ opens, Click on Execute.

A wnNE

This completes the generation of GERBER data.

== Fabrication Data Manager

Categary Gerher Arworks
=g G:Ebef Phatoplotter Data Inciude in Arbwork | Layer Marme Mirror Image | Copper Pour &reas | Boa +
o Gerber Artwarks r L
.~ Gerber Mecharical Plots (] M
= HC-Drill Data O H
¢ e Output Contents ] 0
i~ PCB Assembly Output ] P
i Bare Board Testing ] o
r R
r g
C T
C u
r Y
r W/
C ¥
r v
r z
rd SOLD.LAYER r
r SOLD MASE
r SOLD.FRINT =
4 | [l
Set to Uged | Erecute |
Accept | Cancel |
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File ¥iewer {D:\0OPUSERXP" JOB'RC Coupled Ampljfier_MAINHIER_AW.... [Hi[=] |

=] Fle Edit Search Window Help 12 x|

IERBER JOB REPORT FILE: DAOPUSERKPWOBNRC Coupled Armplifier k&
=end this file to the photplotter house along

with below listed . GBR files

BOARD:RC Coupled Amplifier (MAINHIER) GERBER ASCI Output
DUTPUT FORMAT: Rx-274-X

CODE: ASCIHABSOLUTE IMNCH
SYFORMAT 2.3 - LEADING ZEROS OMITTED
SCALE FACTOR: 1

COffset and Stepping Commands embedded in the file

Offzet: =
Q= I _"|_I

| 1 open document(s), |CHPS (NUM | 15

Preview the GERBER Data

Preprocess the GERBER file

File & GERBER Viewer Setup option. Click on Grid cell in the column GERBER ASCII
File, an ellipsis (a button with 3 dots) appears, click on it and select the required GERBER
ASCII files (*.GBR)..

Gerber Preprocessor and ¥iewer Setup E

Gerber Preprocessar | D#F Preprocessor I Atwaork Yiswer Setup I

Supenimpoze ﬂ
Positive Gerber ASCl File
| Gerber ASCI File Image Plot [superimpozed] Artwork Digplay File Selectioh
" 1 RC Coupled [ RC Coupled Iv

2 RC Coupled r RAC Coupled =

3 RC Coupled r RAC Coupled r

4 RC Coupled ] RC Coupled |

5 RC Coupled ] RC Coupled |

E r r

7 r r

g r r

s C C |
Gerber Input File Parameters : Destination Path I
Output Units Ihches
Omitted £eroes Leading
Scale Factor 1.0 $|
Scah.a .Factu:ur:Y 1.0 Clear &l |
Precizion Factorx 23
Precizion Factory 23
Aperture T able Autogenerated PreProcess |

Cloze |

| Selected: 4 | DAEDWin<PWOBARC Coupled &mplifier_MAINHIER_31.GER
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Multiple Artwork files may also be preprocessed Click ‘Preprocess’ button. The

preprocessing status may be displayed on the status bar and the completion is marked by

a Successfully processed selected files.” message. As a result, artwork file (*.ART) is

created with the name of the source Gerber

Viewing Artwork

1.

a > DN

© © N o

Select Artwork Viewer Setup from Gerber Preprocessor and Viewer Setup
window.

Choose Browse Artworks

Select the .ART files and click on open

Select the files one by one and click on Apply.

The Artwork of a PCB is the actual display of the various copper routes, padstack,
pinholes, etc.. The design data may be viewed layer by layer as it is got on the
photoplotted film or pen plotted artwork. This menu option must be active to view
the various layers of the design individually.

Tools & Artwork / Power & Gnd planes .

Select Define Artworks (function tool)@ Set Used to B Accept.

Select Centreholes from View& Artwork® Centreholes as 1/3 Size.

In order to view layers, Select Tools [TArtwork & Pwr/Gnd Planes use the Layer(
Comp.side & Sold.side) drop down menu and select the required layer. The
artwork for that particular layer may be viewed as it appears. Select Solder Layer

from tool bar.

[ ~oe ] ~shloc ]

7R

g—R
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[ Compaonent Layer T
¢ B O ¢ O n

n ¢ ¢ O o o

o 00 0O
0o

0o on
o0

|
N

[ Component Print

ciclelegele

A 35
_HO I:Ig

|

L

Gerber Mechanical Plots

This window allows setting the parameters for gerber mechanical plots on both
Component and Solder side. The window opens with the Component Side, by default.
Here the Generate Mechanical Plot for Component Side checkbox is unchecked. Enabling
this checkbox displays the list of parameters that may be set.

1. Select Fabrication = Setup. This dialog box is shown below.
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=4 Fabrication Data Manager

Category ical Flots
[ Gerber Photoplatter Data Sallekn Sk I
. Gerber Artworks :
- Gerber Mecharical Plots |w Generate Mechanical Plot for Component Side
E- MC-Diill Data
Output Contents B | Layer for which [Mechanical Plat - Component Side] iz to be generated
-~ PCB Assembly Output Current Layer | COMF
‘. Bare Board Testing Bl | Board entities to be plotted
Bioard Outing [
Board Description Notes =
Dlimenzions v
Companent Outlines =
Bl | Padstack entities to be platted
Pad Frames O
Hole: Outlines O
Execute |
Aocept | Cancel |

2. Click Execute, then a Gerber Output window appears.
3. Click Execute. ‘Gerber ASCII output completed’ message appears in the bottom

of the window. The output obtained will be a text file.

Introduction to NC Drrill

In generating the NC-Drill, the system extracts information about the whole positions, sorts
them according to drill size information. The different hole sizes are grouped together and
generally sorted to drill in a specific order. This grouping may be done based on sizes,
type of drilled hole, like through plated or non-plated, via type like buried or unburied etc.
This is generated as a drill tape data. The data may be used directly on any numerically
controlled drilling machine. This NC-Drill data is of the EXCELLON format, which is the
accepted industry standard.

NC Drill Output Parameters
1. Select Fabrication = Setup = Fabrication data manager = NC-Drill Data.

Depending on the equipment used by the PCB manufacturer some parameters

must be set prior to generation of NC drill files.
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_,_I:::_;fi_]Fahricatiun Data Manager !E E |
Categary MC Drill Diata (Excellon Format)
=- G_erber FPhotoplatter D ata B | Exeellon Dutput Farmat
Gerber Arbworks Output Units Inches
i Gerber Mecharnical Plots Ormitted Zeroes Trailing
i Dutput Content = sk
- DUIpUE Lontents Tool Size Units Inches
----- PCE Azzembly Output : = =
..... Bare Board Testin Tool Size Precizion 2 digits
B Tool Magazine Size 3 Toolz
Bl | MEDill bit rmovement Dptimization
Optimization method [Mone
Azcept Cancel

Output units - Inches or Millimeters.

Omitted Zeroes- Leading or Trailing.

Click on Execute, NC Drill Output window appears.

multiple holes in the same XY position.

2. Set the following parameters
4,
5.
Output Completed’.
6.

Click Close and Accept Fabrication Data Manager.

In this window check Prepare drill database for Template only and Check for

Click on Execute. In this window after execution displays a message ‘NC Drill
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MC-Drill Dutput |

M Drill D atabaze Contents |

Patch: Toal: Size: Holes: | =
Patch 0 Start

T 003" 18

To2 0.035" 3

TO3 0.040" 4
Patch 0 End

Taotal 25 J

[v Prepare Dill Databasze for Template anly
v Check for multiple holes in the same =" position

Report File:

Output T

Template

MC-Dirill Qutput Completed

Cloze |

Preview NC- Drill data:

Select Tools @ Template (notes)

BOARD:  RC Coupled Amplifier
FIM HOLES WIAS TOP - BOTTOH

+ 4+ + + + +

M #-Size: 1.688 inch
m+ + + + + + ¥-Size: 1.180 inch
" v ++ ++ #=Panel: 1.6E3 inch
H e i v—Fanel: 1.188 ihch
L _
FATCH- @

TOOLS: m&C lnch ? Count

+ Ta1 @, 432 12
* TAZ @, 435 3
M TAS @, A4@ 4

Total hales: 23

Introduction to PCB Assembly outputs
When the manufacturing volumes are high and high in component density, designs like

SMD, manual assembly becomes difficult. In such cases, automatic component insertion
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technique is required in a specified format to drive automated machinery to position the
components at exact location. As this data is machine specific, there is a provision for both
Generic as well as IPC-D-355 standard format of the output.

Generate PCB Assembly outputs.

1. Select Fabrication ®»Setup &*PCB Assembly Output.

=2 Fabrication Data Manager

Categary FCB Assembly Outputs
= Gerber Phatoplatter D ata Gemeric  IPC-D-355
' Gerber Artworks = =
i Gerber Mechanical Plats General —
Coordinates Unit Ihches and Degrees L

=) NC-Diill Data
© b Output Contents
bzambly Clutput

Sequence of Component FPD Components first
Sort Part Mame

B |.Job Description
Job Mame

RC Coupled Amplifier

Title RC Coupled Amplifier
Dirawing ?
R ewvizion ?

B | PCE Parameters

Thickness of PCE 0.05906"
Height of PMD components over PCE 0.03937"
Mumnber of PCE Fiducialz 2

PCE Fiducials Size 0.0s00"
PLCE Fiducialz Horizontal Shift 0.0900"
PCE Fiducials “eritzal Shift 00900

Output PCB Patern Tolerance
Output PMD Components Taolerance

i
-
Execute |

Azcept | Cancel

Click on Execute. Output is a extension .PCK extension file.
Save it
Select IPC-D-355 tab on top of the Fabrication Data Manager window.

a M 0D

Click on Execute. Output is a .355 extension file, save it in the desired location.

Introduction to Bare Board Testing outputs

Bare Board Test (BBT) is like quality check usually done by the fabricator to check the
open & short circuits in and between the tracks. A supply of 50 volts is passed through the
tracks and this job is done by automated machines. A probe sort of thing is inserted
through the pads so as to probe. A netlist is generated from the gerber (it is not generated
from the design) so that to cross check the actual physical PCB manufactured with respect
to actual gerber in order to find out the fabrication errors. This is a special on board test

outputs generated in Generic and IPC-D-356A.
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Generate Bare Board Test outputs

Select Fabrication =» Setup. To setup parameters for Bare Board outputs choose Bare
Board Testing node from Fabrication data manager choose either format and set the
required parameters. Click Execute to generate the Bare Board Testing output in either
Generic or IPC-D-356A format.

== Fabrication Data Manager

Categomny Bare Board Test Output

[=I- Gerber Phatoplatter D ata Generic | IPC-D-3584 I
© b Gerber Atworks

. - Gerber Mecharical Plots B | General

- MC-Drill Data Co-ordinates Reference Board ik, vmin

o Dutput Contents Board Yiewed From Top

PCE Assembly Dutput Coordinates Unit Inches

L TPy Testing B | Contents [Connection Points:)
Component Pads X Coordinates v
Component Pads =Y Sizes v
“ia Hole Pads . Coordinates v
Wia Hole Pads *Y Sizes v

B | Contents [Conductors):

Trace 5egments v
Copper Pour Areas [
Flair Copper ltems v

Execute |

Ancept | Cancel

The output for Bare Board Testing is obtained as a text file.
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